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Release 7.1 Configuration 
 

This document describes the new features and enhancements included in Credible 7.1 release. It lists the 
settings necessary to enable each release item along with the steps for configuration and use. Settings 
that are new and specifically needed for a release item are emphasized with italics. 
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CREDIBLE CLIENT PORTAL 
Two-Way Communication Between Client & Agency 
 With the new Messaging function in the Credible Client 

Portal, a client user can send a general message to your 
agency or one about an active medication or scheduled appointment. As a 
reminder, a client user can be the client or a client representative such as a 
parent. If the message type is Medication Refill or Scheduled Appointment, a 
dropdown displays with the client’s active meds or appointments scheduled 
for the current date and future dates. 

Note that the new function utilizes offline messaging and the messages are 
not delivered via email. As shown in the screenshot below, you can configure 
“disclaimer text” to convey the offline nature of the messaging function to 
client users – it displays above the Messaging screens in the Client Portal. 

 
 

A client user does not pick the recipient for the message. By default, it goes 
to the client’s case manager. If one is not assigned, the message goes to all 
primary employees for the client. If there are no primary employees, it goes 
to all employees assigned to the client. 

Once a message has been sent, the client user can reply to it or discard it. 
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Note that with the first release of the messaging functionality, messages can 
only originate from a client user. 

In your Credible system, an envelope icon displays 
in the banner to notify employees that a message 
has been sent from the Client Portal. Hover over 
the icon to see the number of new messages and 
replies. You can control how frequently the system 
checks for new messages with the Check Message 
Interval setting in Partner Config.  

Employees access the Messaging Hub screen by clicking the envelope icon or 
the new Messaging Hub button on the Employee nav bar. 

In both the Client Portal and employee Messaging Hub, the number of replies 
for a message is indicated via a speech bubble. In the message thread, the 
original message is at the top followed by the most recent reply. 

 

Settings You need to have your Implementation or Account Manager turn on the 
Credible Client Portal for your system. 

Partner Config: Check Message Interval, Message Disclaimer Text for Client 
Portal 

Security Matrix: MessagingHubAnswerMessages 

Client User Security Matrix: MessagingCU 

Configuration See Setting Up the Credible Client Portal in the help. 

 

http://help.crediblebh.com/CredibleHelp/default.aspx?pageid=setting_up_the_credible_client_portal�
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Client User Use To create and send a message: 

1. Messaging button on nav bar > New Message button on Messaging 
screen. 

2. Select the message type and the med/scheduled appointment if 
applicable. 

3. Enter the subject and body of the message in the corresponding 
fields. You can format and spell check the message with the tools in 
the text box. 

4. Click Send Message. 

To view a conversation, click the envelope icon, the subject, or the reply 
speech bubble. 

Use the icons in the Options column to reply to or discard a message. 

Employee Use To reply to a message: 

1. Click the envelope icon in the banner or the Messaging Hub button 
on the Employee nav bar. 

2. Click the reply icon  in the Options column. 

3. Enter your reply and click Send Message. 

To view a conversation, click the envelope icon, the subject, or the reply 
speech bubble. 

To discard a message or mark it as unread, use the corresponding icons in 
the Options column. Note that when you discard, it only removes your view 
of the message – the client user and other employees included on the 
message can still view it. 
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CLIENT 
Use Wiley Problems/Goals/Objectives/Interventions in Tx Plus Plans 
 To achieve consistency in the 

problems/goals/objectives/ 
interventions in Tx Plus plans 
– which ones are used and 
how they are described – you 
can now contract to use the 
Wiley treatment planning 
“library” as part of Tx Plus. If 
you select “Use Wiley” when 
you are building a Tx Plus 
plan, the predefined 
problems/goals/objectives/ 
interventions for the treatment plan you select are available via 
dropdowns. 

You can set up your system to use Wiley exclusively or let staff use Wiley 
and free-form entry for the different components in a Tx Plus plan. 

Settings Using the Wiley treatment planning library requires an addendum to your 
contract. For more information, contact contracts@credibleinc.com. Once 
you have contracted to use Wiley, your IM/AM needs to turn on the 
functionality in your system. 

Partner Config: Use Tx Plus, Force Wiley (optional) 

Security Matrix: TxPlusBuild 

Configuration See Tx Plus in the help. 

Use 1. Tx Plus on Client nav bar > New TxPlus button. 

2. Select Use Wiley checkbox and select a treatment plan from the list. 

3. Click Problem in the TxPlus Items box to add it to the plan. 

4. Click the Problem name field to display a list of problems associated 
with the treatment plan you selected. 

5. Select the appropriate problem. Note: if Force Wiley is not selected, 
staff can edit the actual problem (goal, and so on) text. When the 
Partner Config setting is selected, staff can only use the text as is. 

6. Change the start date if necessary and enter a target date. 

mailto:contracts@credibleinc.com�
http://help.crediblebh.com/crediblehelp/default.aspx?pageid=tx_plus�
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7. If applicable, use the Select Axis link to associate the problem with one 
of the client’s diagnoses. 

8. Click the Problem to make it the active level (color changes to yellow). 

9. Click Goal in the TxPlus Items box to add it to the problem. 

10. Click the Goal name field to bring up predefined goals associated with 
the problem. 

 
11. Select the appropriate problem. 

12. Add objectives and interventions in a similar fashion. 

13. Add additional problems and sublevels as necessary. 

14. Click Save. 

Creating & Using Tx Plus Templates 
 To save time when building Tx Plus plans, you can now save existing plans 

as templates and have staff use them instead of building the treatment plan 
structure on the fly. When you save an existing Tx Plus plan as a template, 
the system does not retain the program selected, any dates entered, or any 
documentation entered against the plan. In addition, start dates are not 
required like they are when you save a Tx Plus plan for a client. 

You can also use the new Admin function TxPlus Templates to build a 
template and manage existing templates.  

Settings Partner Config: Use Tx Plus 

Security Matrix: TxPlusView, TxPlusBuild 

Configuration See Tx Plus in the help. 

  

http://help.crediblebh.com/crediblehelp/default.aspx?pageid=tx_plus�
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Use To create a template from an existing Tx Plus plan: 

1. Tx Plus on Client nav bar > edit button for Tx Plus plan you want to 
save as a template. 

2. Select the Save Tx as Template checkbox, enter a name in the Tx 
Name field, and click Save. 

To view, edit, or delete an existing template: Admin tab > TxPlus 
Templates. Use appropriate button for existing template. Note that 
deleting a TxPlus template merely removes it from the Load Template 
dropdown – it does not affect client Tx Plus plans built off of that template 
The same holds true for when you edit a template. 

To use a template when building a Tx Plus plan for a client: 

1. Tx Plus button on Client nav bar > New TxPlus button. 

2. Select the template from the Load Template dropdown. 

3. Select a program (if applicable) and enter the appropriate Start and 
Target dates. 

4. If applicable, select a method (visit type group) for the Tx Plus plan. 

5. Make any necessary changes to the structure of the plan and click 
Save. 

Active Flag to Control Availability of Tx Plus Plan in Form 
 If your agency needs to approve a Tx Plus plan before making it available in 

a Tx Plus form, you can set up your system to show only active Tx Plus plans 
in forms. Once a Tx Plus plan has been approved, you can flag it as Active 
and then it will be available to document against. You can control which 
employees can flag a Tx Plus plan as active with the new Security Matrix 
right TxPlusActivate. 

Notes: 

If a Tx Plus plan is used for a visit and then set to “inactive,” it will still show 
up for that visit. 

Settings Partner Config: Use Tx Plus, Show Active Tx Plus Plans In Forms 

Note: if Show Active Tx Plus Plans In Forms is not selected, all Tx Plus plans 
added default to active status. 

Security Matrix: TxPlusActivate 
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Configuration See Tx Plus in the help. 

Use After a Tx Plus plan has been approved: 

1. Tx Plus on Client nav bar > edit button for the plan. 

2. Select the Active checkbox and click Save. 

Notes: 

• If you don't have the TxPlusActivate right and you edit an active 
TxPlus plan, the plan will automatically become inactive. 

• If you do have the TxPlusActivate right and you edit an active 
TxPlus plan, it will remain active unless you specifically uncheck the 
Active checkbox. 

Existing Tx Plus Visits Locked Against Tx Plus Plan Edits 
 When a Tx Plus plan is edited, existing visits based on the original version 

will not be affected. Only new Tx Plus visits will reflect the new structure. 
Note that if a Tx Plus plan is edited, cloning a visit will now display the new 
version. And as a reminder, you can only have one Tx Plus plan per program 
per time frame regardless of its active/inactive status. 

Settings Partner Config: Use Tx Plus 

Security Matrix: TxPlusView, TxPlusDocument 

Configuration/Use See Tx Plus in the help. 

Notification Triggers 
 With a new notification trigger, TxPlus Problem Add, you can inform the 

appropriate staff when a problem (the highest level) is added to a Tx Plus 
plan. In addition, the TxPlan Add and Treatment Plan End Date notifications 
have been updated to work with Tx Plus plans. TxPlan Add will trigger when 
a new Tx Plus plan is added to a client record. Note that it will not trigger 
when documentation is added to an existing Tx Plus plan. 

Settings Partner Config: Use Tx Plus 

Security Matrix: NotificationTriggers 

Configuration/Use See Notification Triggers in the help. 

http://help.crediblebh.com/crediblehelp/default.aspx?pageid=tx_plus�
http://help.crediblebh.com/crediblehelp/default.aspx?pageid=tx_plus�
http://help.crediblebh.com/crediblehelp/default.aspx?pageid=Notification_Triggers�
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Viewing Tx Plus Treatment Plans in Client Portal 
 You now have the option of making Tx Plus treatment plans available to 

client users via the Client Portal. 

Note: if one of the client’s diagnoses is linked 
to a problem in a Tx Plus plan, a client user 
will be able to view the diagnosis code by 
hovering over the Diagnosis magnifying glass.  

Settings Partner Config: Use Client Portal, Use Tx Plus 

Security Matrix: ClientUserView 

Client User Security Matrix: TxPlusViewCU 

Configuration See Setting Up the Client Portal in the help. 

Use See Credible Client Portal in the help. 

Active Tx Plus Plans Added to Client Profile Print View 
 You can now select Tx Plus as a print option when generating a client 

profile print view. When selected, the system prints the structure but not 
the documentation for all Tx Plus plans that have do not have an end date 
or have a future end date. 

Settings Partner Config: Use Tx Plus, Use Tx Plan Methods (optional) 

Configuration See above. 

Use 1. Profile button on Client nav bar > Print View button. 

2. Select Tx Plus and any other print options as appropriate. 

3. Click Print View. 

End Date Autopopulates in Sublevels Without One 
 To save time when end dating levels in a Tx Plus plan, the system 

autopopulates the date you enter in the End Date field for a level in any 
sublevel that does not have an end date. For example, if you enter an end 
date in a Problem level, it autopopulates for any goal, objective, or 
intervention level that does not have one. 

http://help.crediblebh.com/CredibleHelp/default.aspx?pageid=setting_up_the_credible_client_portal�
http://help.crediblebh.com/CredibleHelp/default.aspx?pageid=credible_client_portal_start_over�
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Settings Partner Config: Use Tx Plus, Problem/Goal/Objective/Intervention Label, 
Problem/Goal/Objective/Intervention Background Color, Use Tx Plan 
Methods (optional) 

Security Matrix: TxPlusDocument 

Configuration/Use See Tx Plus in the help. 

Collapse All/Expand All Toggle Added to Tx Plus Category 
 When you are documenting against a Tx Plus plan in a form, a Collapse 

All/Expand All link is available to make it easy to show and hide all sublevels 
for all problems. 

Settings Partner Config: Use Tx Plus, Problem/Goal/Objective/Intervention Label, 
Problem/Goal/Objective/Intervention Background Color, Use Tx Plan 
Methods (optional) 

Security Matrix: TxPlusDocument 

Configuration/Use See Tx Plus in the help. 

Build Tx Plus in Web Form Without Intake Nav Bar 
 If a client does not have an active Tx Plus plan, you can use the new ADD TX 

PLUS link in a web form to build one. Note that the link only displays in 
forms that have a Tx Plus category.  

 

Settings Partner Config: Use Tx Plus, Problem/Goal/Objective/Intervention Label, 
Problem/Goal/Objective/Intervention Background Color, Use Tx Plan 
Methods (optional) 

Security Matrix: TxPlusBuild, TxPlusDocument 

Configuration See Tx Plus in the help. 

http://help.crediblebh.com/crediblehelp/default.aspx?pageid=tx_plus�
http://help.crediblebh.com/crediblehelp/default.aspx?pageid=tx_plus�
http://help.crediblebh.com/crediblehelp/default.aspx?pageid=tx_plus�
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Use For any client without a Tx Plus template: 

1. Begin a visit linked to a form with a Tx Plus category. 

2. Click ADD TX PLUS in left side of form. The Client Tx Plus Builder 
screen displays. 

3. Build the Tx Plus plan as you normally would and save. The Tx Plus 
tree structure displays in the left side of the form. 

4. Document against the Tx Plus plan and complete the visit. 

Note that the ADD TX PLUS link is not available when you edit the full visit 
via the Visit Details screen. It is also not available when a client has an 
active Tx Plus plan that is applicable to the visit (a client can have multiple 
active Tx Plus plans for different programs). 

Green Checkmark for Completed Tx Plus Category 
 When documenting against a Tx Plus plan in a web form, a green checkmark 

now displays when you complete the Tx Plus category. 

Settings Partner Config: Use Tx Plus 

Security Matrix: TxPlusDocument 

Configuration/Use See Tx Plus in the help. 

Process for Tx Plus Plans and Late Entry Visits 
 The system can only prevent a user from documenting against an inactive 

Tx Plus plan when the Add Visit (or Quick Visit) function is used. If the visit 
date entered in the Enter Visit screen precedes the start date for a Tx Plus 
plan, it will not be available. For this reason, staff should be trained to use 
the Add Visit/Quick Visit functions vs beginning a visit from the Schedule 
when documenting against a Tx Plus plan. 

Settings Partner Config: Use Tx Plus 

Security Matrix: TxPlusDocument 

Configuration/Use See Tx Plus in the help. 

http://help.crediblebh.com/crediblehelp/default.aspx?pageid=tx_plus�
http://help.crediblebh.com/crediblehelp/default.aspx?pageid=tx_plus�
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Days Added As Count Type for Authorizations 
 With Days as a new Count type, you can accommodate a 

payer that has an authorization with a unit type of days. 
While there can be multiple visits in a day, they only count as 
one “auth day.” 
The Days Count type is available when adding an 
authorization or authorization level. 

Settings Partner Config: Use Authorization Levels (optional) 
Security Matrix: AuthorizationView, AuthorizationAdd 

Configuration N/A 

Use See Authorizations and Authorization Levels in the 
help. 

Monthly By Day Period Type in Client Authorizations Screen 
 The MONTHLY BY DAY period type is now available in the Client 

Authorization screen. Previously, it was only available when setting up an 
authorization level.  

Settings Security Matrix: AuthorizationView, AuthorizationAdd 

Configuration N/A 

Use See Authorizations in the help. 

Second Phone Number Field Added to Family Members Screen 
 With the new Phone2 field, you can now enter two phone numbers for 

each family member. For a more consistent look and feel in the Family 
Members screen, the fields have been reengineered. 

Settings Partner Config: Use Client Family 

Security Matrix: ClientUpdateContactsFamily 

Configuration N/A 

Use 1. Family button on Client nav bar > Add Family Members button (or 
select button to update an existing record) 

2. Fill out (or update) fields and click Add New Family Member (or Save 
Family Member if updating). 

http://help.crediblebh.com/crediblehelp/default.aspx?pageid=Auths�
http://help.crediblebh.com/crediblehelp/default.aspx?pageid=Authorization_Levels�
http://help.crediblebh.com/crediblehelp/default.aspx?pageid=Auths�
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YOQ: Access Client Links via Client and Intake Nav Bars 
 With a new Security Matrix right, you can make a Client Links button 

available on the Client nav bar and Intake nav bar. (The Intake nav bar is a 
subset of the Client nav bar that you can make available within a web 
form.) Currently, the Client Links function is only in use for Youth Outcome 
Questionnaire (YOQ) and the links are hardcoded into your system. 

Settings YOQ is for agencies that have a contract with YOQ, which is separate from 
Credible. 

Security Matrix: ViewClientLinks 

Configuration 1. Admin tab > Home Page Config. 

2. Click Client Navigation, select Include in Intake for Client Links, and 
save. 

3. To activate the Intake nav bar in a form: edit the form, select Show 
Intake Nav Bar, save the change, and build and activate the updated 
form. 

Use Client tab > Client name or view button to access Client Overview screen > 
Client Links on Client nav bar 

From within a web form: Client Intake link on left side of form > Client 
Links button on Intake nav bar 
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EMPLOYEE 

Assigning Billing Groups to Employees 
 With the new Billing Groups assignment function, you can control which 

billing groups are available to each employee when they enter, sign and 
submit, and update a visit. If you do not assign billing groups to an 
employee, all groups will be available in the Billing Group dropdown. If 
you assign one or more billing groups, only the assigned ones will be 
available. 

As shown on the right, 
there is one exception to 
this. If you assign one or 
more billing groups and 
have an unassigned billing 
group set as the default, 
the default plus the 
assigned ones will be in the 
Billing Group dropdown. 
 

When the default billing 
group is set or changed in 
the Employee Billing Groups 
screen, it will be reflected in 
the Employee Profile and 
vice versa. You can assign a default to an employee without assigning any 
billing groups (all billing groups will be available in the Billing Groups 
dropdown). The new Billing Groups function does not affect the 
functionality behind the billing group assignment for Billing Matrix 
entries. 

Settings Partner Config: Billing Group Dropdown 

Security Matrix: BillingGroupsView, BillingGroupsAssign 

Configuration To set up billing groups: Billing tab > Billing Groups Table > Add a New 
Billing Group Entry 

Use 
on the Employee nav bar. 

To assign/unassign a billing group, click the assign/unassign button. 

To set or change the default billing group, click the no button to change it 
to yes. 
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VISIT 

Reporting e-Prescribing G-Codes 
 With the new ability to 

report on G-codes, it 
will be easier for your 
organization to obtain 
the Medicare incentive 
for e-prescribing. When 
you sign and submit a 
visit or update a 
completed visit, you 
can flag the visit for an 
eRx G-Code. Behind the 
scenes, the system 
creates a secondary 
visit for billing 
purposes. If you follow 
the best practice of 
setting the eRx G-code Billing Matrix entry to Auto Approve, it will free up 
your clinical staff from having to approve the secondary visit. 

Because the eRx G-code visit is a secondary visit, it will not decrement an 
authorization. 

To use the eRx G-code functionality, you have to create the visit via a web 
form. You can control which employees can create eRx G-code visits with 
a new Security Matrix right. Note that you cannot undo (roll back) an eRx 
G-code primary/secondary split. 

For more information on the Medicare eRx Incentive Program, click here. 

Settings Partner Config: Flag for G-code 

Security Matrix: ClientVisitCreateGCode 

Configuration 1. Copy the appropriate Billing Matrix line. 

2. Make any necessary CPT code changes for the copied entry, select “Is 
e-Prescribing G Code,” select “Auto Approve,” and save. 

http://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/ERxIncentive/index.html�
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Use When signing and submitting 
a visit, select the Yes radio 
button for Create eRx G-
Code. When updating a 
completed visit, select the 
Create eRx G-Code checkbox. 
 

If the matching Billing Matrix line for the primary visit was not set to auto 
approve, it displays in the default “Not Approved” Client Visit List with an 
Rx icon. 

 
To view the secondary visit that was created, filter the Client Visit List by 
the Approved status. It will also have an Rx icon. 

In the Visit Details screen, you can click the Secondary (or Primary) link in 
the Merged/GCode field to view the details for that visit. 

 

Signature Count Field Counts Actual Number of Signatures in Visit 
 To help you monitor whether a visit has the expected number of 

signatures, the Signature Count (signature_cnt) field now reflects the 
actual number of signatures in a visit. Previously the field indicated the 
number of the highest signature box in a visit. 

Note that this change has no impact on visits with previously saved 
signatures. 

Settings Security Matrix: AdvSearch, AdvSearchExport 

Configuration To make signature_cnt available as a custom field, use Data Dictionary to 
add to the Client Visit table.  

 



 

 

Visit 16 Release 7.1 Configuration (v 1.2) 

Use 1. Visit tab > advanced search button. 

2. Click Custom Fields > More Fields. 

3. Select Signature Count (in the ClientVisit section) and click Save List 

4. Select other search criteria as appropriate and click Filter. 

Block Overlapping Visits Based on Employee & Visit Type 
 With a new Partner Config setting, you can prevent an employee from 

submitting a visit if it overlaps a completed visit on his or her schedule and 
has one of the visit types specified. The block occurs for data entry and 
web form visits and you can exclude non-billable visits from the block. 

This new setting is similar to Block Overlapping Clients by Visit Types that 
blocks the submission if the visit overlaps a completed visit on the client’s 
schedule and has one of the visit types specified. 

Settings Partner Config: Block Overlapping Employees by Visit Types 

Security Matrix: VisitDataEntry or VisitEntryWeb 

Configuration N/A 

Use N/A 
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ADMIN 
Generate Notifications Based on Employee Profile Date 
 With the new Employee Profile Date Field trigger, you can send out 

notifications based upon any date field set up in the Employee profile 
through Data Dictionary. For example, you can base the trigger on a 
performance evaluation date or CPR training expiration date. 

Settings Security Matrix: NotificationTriggers 

Configuration N/A 

Use 1. Admin tab > Notification Triggers > Add a New Trigger Entry. 

2. Select Employee Profile Date Field Trigger and select field. 

3. Enter a title for the notification and select desired Send To options. 

4. In the Occur field, enter the number of days before or after the date 
entered in the Employee profile field that you want the notification to 
go out. For example, for a CPR expiration date, enter -30 so the 
notification is sent 30 days before the expiration date. 

5. Select the desired notification checkboxes and click Save. 

Notification Triggers: Assignment Not Required for Profile 
 If you need to send a notification to employees with a specific profile 

regardless of client assignment (for example, Billing Staff), select the 
profile in the corresponding dropdown and select the new checkbox 
“Assignment Not Required.” This feature is recommended for security 
profiles that have the ClientListAll and ClientViewAll rights, as these 
people can already see every client regardless of assignment. 

Settings Partner Config: Assignment Not Required 

Security Matrix: NotificationTriggers 

Configuration N/A 

Use See Notification Triggers in the help. 

 
  

http://help.crediblebh.com/CredibleHelp/default.aspx?pageid=Notification_Triggers�
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Task Ticket Enhancements 
 The notes for a task ticket are now ordered chronologically with the most 

current note at the top. Area and Submitted By filters have been added to 
the Credible Task Tracker Report. In addition, the Task Ticket submission 
form has a new field Web Browser & Version. 

Settings Security Matrix: SubmitTaskTicket, ReportList 

Report Security: Credible Task Tracker Report 

Configuration 1. Admin tab > Home Page Config > Home Page Admin. 

2. Select Links and save. 

Use Home Page > Submit Task Ticket link in Links section 

Reports tab > Admin > Credible Task Tracker Report 
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BILLING 

Send Paperwork Type/ID & Transmission Type with 837 
 When you add an 

attachment to a visit, you 
can specify the paperwork 
type, transmission type, 
and paperwork ID and have 
that information sent with 
the 837 in a PWK loop. 

Note that if paperwork type 
and transmission type have 
not been entered for a file, 
the PWK segment will not 
be sent. If paperwork ID is 
not entered, the PWK loop 
will not be sent. The 
exception to this is the At 
Provider Site transmission 
type – it does not require a 
paperwork ID and the ID will 
not be sent if entered. Since 
the fields are not required in 
the Attach File screen, you will need to train staff to enter the 
information. 

Paperwork information for the most recent attachments (up to 10) will be 
sent. In the example below, the visit has three attachments. 

PWK*13*EL***AC*9847~PWK**XP*AA~PWK**A3*FT***AC*2342~< 

If the visit is a merged visit, the system will send paperwork information 
for all visits in the merge.  

Settings Partner Config: Use Paperwork Segment for Visit Attachments 

Security Matrix: BillingConfig, ClientVisitFileAdd, ClientVisitUpdate 

Configuration 1. Billing tab > Billing Payer 

2. If a payer accepts the paperwork information, edit its config file, select 
Send Paperwork, and save. 
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Use 1. Access Attach File screen for the visit: ATTACHMENTS link in Sign & 
Submit page in a web form or Attach New button in Visit Details 
screen for completed visit. 

2. Select the paperwork type and transmission type from the dropdowns. 

3. Enter the paperwork ID (up to 80 characters). Do not use the tilde 
symbol (~) in the ID. 

4. Enter a description (or select from dropdown if available). 

5. Use the Browse button to select the file and click Upload File. 

When batching this visit to a payer that accepts the PWK segment, the 
paperwork information will automatically be included in the batch file. 

Send Occurrence Information in the 837I 
 With a new Payer Config setting, you can send occurrence information in 

the 837I. When “Send Occurrence Information” is selected, the system 
sends the HI*BI & HI*BE loops with default qualifiers of M0 and 80. You 
should only select this setting when required by the payer. 

HI*BI*M0 & HI*BE*80 

Settings Security Matrix: BillingConfig 

Configuration 1. Billing tab > Billing Payer. 

2. If a payer requires occurrence information, edit the payer’s config file, 
select Send Occurrence Information, and save. 

Use N/A 
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Maximum Claims Per Client Per 837 Batch & Visits Per Claim 
 If a payer has a maximum number of claims that it allows per client 

per 837 batch, you can enter the amount in a new setting in Payer 
Config. When the amount specified in “Max Claims Per Client Per 
Batch” is reached, the system no longer includes the client in the 
batch and prompts the user to generate another batch to cover the 
remaining claims. 

A payer may also have a maximum number of visits it allows in one 
claim when submitting multiple visits per claim. To avoid rejections 
based on this maximum, enter the amount in the new setting “Max 
Visits Per Claim.” If the maximum amount is reached, the system 
creates another claim (2300 loop). 

Note that the existing “Max” Payer Config setting, Max Visits Per 
Batch, remains unchanged. 
  

Settings Security Matrix: BillingConfig 

Configuration 1. Billing tab > Billing Payer. 

2. If a payer has a maximum for the number of claims per client per 
batch or the number of visits per claim when submitting multiple visits 
per claim, enter the amount in the corresponding field and save. 

Use 1. Billing tab > Generate Batch Claim File. 

2. Select the appropriate criteria and click Filter Batch. 

3. Click Generate Text File for Batch. If the maximum number of claims 
per client per batch for this payer has been exceeded, the HIPAA 837 
Batch File Download screen displays as follows: 

 
4. Click Return to Generate Batch page and repeat steps 2 and 3 to 

generate another batch to address the claims that were excluded. 
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Billing Matrix Payer Setting: Opt Out of Scheduling Block 
 If you assign employees to a payer and block non-assigned employees 

from scheduling visits (via Block Not Assoc Employee Scheduling in 
Partner Config), you can now opt out of the block for that payer for 
specific Billing Matrix entries. If the payer-specific Block Emp Opt Out is 
selected and a schedule item matches on the Billing Matrix entry and 
payer, an employee not associated with the payer can schedule the visit. 

Settings Security Matrix: BillingConfig 

Configuration 1. Billing tab > Billing Matrix. 

2. Edit the appropriate Billing Matrix entry and click the Payer Specific 
Rates & Codes button. 

3. Select a payer that has assigned employees. 

4. Select Block Emp Opt Out and click Update. 

Use N/A 

Custom Rate & CPT Modifer for Payer Based on Custom Roll 
 With new fields in the Billing Matrix Payer Rates and Codes screen, you 

can set up a payer to use a custom rate and CPT modifier when a custom 
roll is reached. The custom roll consists of two values: 

• Custom min total – minimum total of visits that need to be 
included in the roll 

• Custom min line – minimum number of visits that have been rolled 
together to “make” the primary visit that equals the Billing Matrix 
line. As a result, the only ones that count are the ones that match 
the Billing Matrix line. 

If both values are not met, the system uses the Billing Matrix or payer-
specific rate and CPT modifier. You should only use this feature when the 
payer requires a rate or modifier change for this specific scenario. 

Settings Security Matrix: BillingConfig 

Configuration 1. Billing tab > Billing Matrix. 

2. Edit the appropriate Billing Matrix entry and click the Payer Specific 
Rates & Codes button. 

3. Select the appropriate payer. 
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4. Enter the payer-specified values in the Custom Min Total/Line fields 
and the Custom Rate/Mod 1 fields and click Update. 

Use N/A 

Processing Additional CAS : CO Segments & Third CAS : PR Segment 
 Functionality for the 835 has been updated to support a second and third 

CAS : CO segment and a third CAS : PR segment. In addition, a warning 
now displays on the Reconcile screen when there is more than one 
adjustment per segment – because the adjustment segments need to be 
processed manually. In a future release, functionality will be added to 
automate this process. 

The warning 
tooltip lists the 
adjustment 
segments that 
need manual 
processing. 

Settings Security Matrix: BillingModule 

Configuration N/A 

Use Once you upload an 835, you can access the Reconcile screen by clicking 
‘Click here to continue processing claim records.’ Otherwise: 

1. Billing tab > 835/EOB Claim Payment Advice > Display Previous 
835/EOB Batches. 

2. Click view claims button or the 835 ID to get to the Reconcile screen. 

3. Hover over orange warning icon to view adjustment segments that 
need to be processed manually. 

 



 

 24 Release 7.1 Configuration (v 1.2) 

REPORTS 

Importing Agency Information 
 With the new Agency table in Data Dictionary, you can import agency 

information such as agency name, contact info, address, and whether or 
not the agency accepts data in HL7 format. 

Settings Security Matrix: DataDictionary, ReportList, ImportBuild, ImportRun 

Configuration 1. Admin tab > Data Dictionary. 

2. Table Source = Agency and Type = View. 

3. Add the columns (fields) that correspond to the data you will be 
importing. 

4. Click Match Update to View or add the same fields manually to the 
Update type for this table. 

Use 1. Reports tab > Import tool. 

2. Select Agency from Table dropdown. 

3. Select Delimited as the format of import file, enter a comma as the 
Delimiter, and click Add New Import. 

4. In the Import Builder screen, enter a name for your import, select the 
appropriate import settings, and then select the fields that are in your 
import file. Two notes: 

• Application Name field is not used. 

• To use Agency ID, you need to select the Use Internal ID 
checkbox and know the ID. 

5. Click Next Step. 

6. Using the Column Order dropdowns, order the selected fields so there 
is an exact match with the order of the fields in the import file and 
click Reorder. 

7. Click Finish. 

See Import Tool in the help for more information. 

 
  

http://help.crediblebh.com/CredibleHelp/default.aspx?pageid=Import_Tool�
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Importing Medical Profile Information 
 With new fields in the Client Medical Profile table, you can now import 

medical profile information for clients. New fields include client_id, 
clientmedicalprofile_id, active, effective_date, and createdby_emp_id. 

Settings Security Matrix: DataDictionary, ReportList, ImportBuild, ImportRun 

Configuration 1. Admin tab > Data Dictionary. 

2. Table Source = Client Medical Profile and Type = View. 

3. Add the columns (fields) that correspond to the data you will be 
importing. 

• clientmedicalprofile_id is only needed to update an existing 
medical profile. If updating an existing medical profile record, you 
must select Use Internal ID when building the import. When 
updating, client_ID is not needed unless the client associated with 
the medical profile is being changed. 

• client_id is needed to create a new medical profile for a client. 
When building the import, it is important that you do not select 
Use External ID or Use Internal ID in this situation. Do not include 
clientmedicalprofile_id. 

4. Click Match Update to View or add the same fields manually to the 
Update type for this table. 

When creating new medical profile records, active defaults to true. The 
best practice is to import them in as inactive (0) to avoid having multiple 
active medical profiles. The minimum fields for creating a new record (in 
addition to any vital sign fields) are as follows: 

a. client_id 
b. active (0) 
c. effective_date (the date the vitals were taken, appears in the 

upper left of the medical profile) 
d. createdby_emp_id (ID of the employee who took the vitals) 

Use 1. Reports tab > Import tool. 

2. Select Client Medical Profile from Table dropdown. 

3. Select Delimited as the format of import file, enter a comma as the 
Delimiter, and click Add New Import. 
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4. In the Import Builder screen, enter a name for your import, select the 
appropriate import settings, and then select the fields that are in your 
import file. Two notes: 

• If clientmedicalprofile_id is included (for updating an existing 
medical record), you must select Use Internal ID. 

• If client_id is included (to create a new medical profile for a client), 
do not select Use Internal ID. 

5. Click Next Step. 

6. Using the Column Order dropdowns, order the selected fields so there 
is an exact match with the order of the fields in the import file and 
click Reorder. The first column in the source import must be 
clientmedicalprofile_id. 

7. Click Finish. 

See Import Tool in the help for more information. 

Duplicate Visits Blocked on Import to Client Visit Table 
 To prevent you from importing the same visit more than once, the system 

now checks for and blocks duplicate visits from being imported. If a visit in 
the import file has the same external ID as an existing visit, the import is 
blocked and the error is indicated in the import log. 

Post Query Error: External_id already present: 12345; row will be ignored. 

To accomplish the duplicate block, the external_id field was added to the 
Client Visit table and the post query process for the ImportClientVisit table 
was updated. 

The ImportClientVisit table is typically used with a flex rate visit type to 
import client balances. For more information on the ImportClientVisit 
table, see Reference 33050 in the Library. 

Settings Security Matrix: ReportList, ImportBuild 

Configuration Use Data Dictionary to add the fields for ImportClientVisit. If the internal 
Credible IDs are not being used for the import (for example, the Program 
Code is in the import file instead of the numeric autoassigned Program 
ID), you need to set up the lookups accordingly. 
 

Use 1. Reports tab > Import Tool on nav bar. 

http://help.crediblebh.com/CredibleHelp/default.aspx?pageid=Import_Tool�
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2. Select ImportClientVisit from Table dropdown and Comma Separated 
from the Format dropdown. 

3. Click Add New Import and enter an Import Name in the Import Builder 
screen. 

4. Leave the default values for Format, Delimiter, Replace/Delete ALL, 
and Post Query as is. Select other settings as appropriate. 

5. To enable the duplicate visit block, select external_id from the list of 
available columns (fields). You also have to have an external ID from 
the other system. 

6. Select all other fields that are in the import file. 

7. Click Next Step and then click Finish in the Import Details screen. 

8. In Import List, click run for the import you created above. 

9. Use Browse button to find/select your import file and click Upload File 
Now. 

Labs Tables Added to Credible BI 
 When building a view in Credible BI, you can now include the following 

tables: lab.Facility, lab.Report_Accession, 
lab.Report_Accession_Comment, lab.Report_Image, 
lab.Report_Procedure, lab.Report_Procedure_Comment, 
lab.Report_Result, lab.Report_Result_Comment, lab.Report_Test 

Settings Your IM/AM needs to turn on Credible BI functionality in your system. 

Configuration N/A 

Use Refer to Library reference 33124 for user documentation. 

 



 

 28 Release 7.1 Configuration (v 1.2) 

CROSS-BROWSER COMPATIBILITY 

Structure for Signature Pad Cross-Browser Support 
 The structure to support signature pad use with Safari®, Chrome, and 

Firefox® has been developed and incorporated into Release 7.1. We are 
working directly with Topaz to develop the applet (a Java program) 
necessary to enable signature pad use with your non-IE browser. Because 
the signature pad cross-browser structure already exists, you can start 
using the signature pad when the applet becomes available – you won’t 
have to wait for the next Credible release. 

This release also contains patches for known cross-browser issues when 
signing with a tablet. As a result, you can use Tablet Signature with a 
supported browser while waiting for the "Sig Pad" applet. 

Settings N/A 

Configuration N/A 

Use N/A 

 
Safari is a registered trademarks of Apple, Inc. 

Chrome is a trademark of Google Inc. 

Firefox is a registered trademark of the Mozilla Foundation. 
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FUNDS 

Add Allocation via Sign & Submit 
 When a visit type is set up 

to work with the Funds 
module, an “Is Fund” 
checkbox is now available 
on the Sign & Submit 
screen. Previously, the 
only way to allocate a 
fund to a service was via 
the Add Allocation button 
on the Visit Details screen 
(button is only available if 
the visit is unapproved). 

Once an allocation has 
been added, you can view 
it via the Funds button on 
the Client nav bar or the 
Funds Activity Report (Funds tab). 

Settings A contract addendum is necessary to use the Funds module. For more 
information, contact contracts@credibleinc.com. Once contracted, your 
IM/AM needs to turn on the Funds module in your system. 

Security Matrix: FundsAdd, FundsModule, FundsPayment, FundsView 

Configuration 1. Admin tab > Visit Type. 

2. Edit an existing visit type or create a new one, select Is Fund, and save. 

Use To add an allocation via the Sign & Submit screen: 

1. Select the Is Fund checkbox. 

2. Select the appropriate fund/fund type and enter the amount of 
the allocation. 

3. Enter your password and click Sign and Submit. 

 
  

mailto:contracts@credibleinc.com�
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Assign Start and End Dates to Funds 
 To accommodate funds that start and end mid-calendar year, you can now assign 

Start and End dates to each Fund/Fund Type. To help you search for a Fund/Fund 
Type, Start Date and End Date have been added as filtering fields to the Funds 
Budget and Budget Report screens. 

 

While the dates are optional, if you enter a Start or End Note, the other date is 
required. The same applies to searching for funds – leave both fields blank or 
enter a date range. 

Note that the Budget Year is the primary search criteria for the Funds Budget and 
Budget Report screens – if you enter a date range, it has to include the selected 
budget year. 

Settings Security Matrix: FundsBudget, FundsModule, FundsReport 

Configuration N/A 

Use To add start and end dates to a fund/fund type: 

1. Funds tab > Funds Budget. 

2. Enter the start and end dates for one or more fund/fund types and click 
Update Budget. 

To search for a fund/fund type: 

1. Funds tab > Funds Budget or Budget Report. 

2. Enter the start and end date in the corresponding filtering fields. 

3. Select a fund if appropriate and click Filter. 
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Delete Button Added to Funds List Screen 
 When a fund is no longer available, you can now remove it from the system via 

the delete button on the Funds List screen. 

 

Settings Security Matrix: FundsBudget, FundsModule, FundsReport 

Configuration N/A 

Use Funds tab > Funds List > delete button. 
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PATCH LIST 

General 

Clicking logout Button when Intention Is Help Icon 

Task # 25866 

What was the issue? Due to the proximity of the Help icon and logout button in the banner, 
users clicked logout button by mistake when trying to access online help 
(reported at the Partner Conference). 

The patch Amount of space between the help icon and logout button has been increased. 

Credible eRx 

Only First Drug Class Displayed in Credible eRx Report 

Task # 23650 

What was the issue? Prescribed medication was in multiple drug classes but only first drug class 
in list displayed. 

The patch To help you audit medications prescribed to clients, the Credible eRx Report now 
displays all drug classes that a med belongs to. 

Refill by Nurse: Submit for Approval vs Send to Pharmacy 

Task 23791 

What was the issue? When nurse clicked Refill button, script went directly to pharmacy instead 
of going to physician for approval. 

The patch Submit for Approval button will be available for refills for non-prescribers 
and non-prescribers with prescriber right (PrescriptionCreateNonSPI). 
Refill button is only available for prescribers, non-prescribers with 
prescriber right, and employees with RxRefill right. 

 
  



 

 

Patch List 33 Release 7.1 Configuration (v 1.2) 

Client 

Canceling Update to Cloned Authorization Results in Deletion 

Task # 25143 

What was the issue? Added an auth and then cloned it. Updated the cloned auth but then 
clicked cancel. Auth was deleted. 

The patch After an auth is cloned, the Cancel button behaves in the expected way. 

Adding or Deleting an Insurance with Batched Visits 

Task # 15173 

What was the issue? When you add an insurance to a client’s record and a BATCHED service 
exists, the payer is an allowed payer on the service but if it should be the 
next payer, it is bypassed unless you update the service. In other words, if 
you added or deleted an insurance from the client's record and there 
were BATCHED visits that should match to this insurance, the insurance 
was not attaching or unattaching to the visit. 

The patch If you add or delete a client insurance with a billing order greater than the 
current billing order that the visit is batched to, the insurance will properly 
attach to the visit or detach if deleting. 

Dropdown with File Attachment Names Available in Edit Mode 

Task # 25357 

What was the issue? When editing an attachment, the dropdown with predefined file 
attachment names was not available. The only way to update the name 
was to enter a new name in the corresponding field. 

The patch The dropdown with predefined file attachment names is now available 
when editing a client or employee attachment. 

Unable to Move Attachment to New Folder 

Task # 26131 

What was the issue? Unable to move a client attachment from its current folder to another 
folder when file name had special characters in it (for example, # and ?). 

The patch Move attachment functionality has been updated to accommodate file 
names with special characters. Patch applies to client, employee, and 
clinical support attachments. 
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Case Manager Not Showing After Employee Unassignment 

Task # 24897 

What was the issue? When any employee was unassigned from a client, the Case Manager 
assignment would no longer show in the Client Overview screen unless 
the case manager was unassigned and reassigned. 

The patch The case manager employee ID field will only be updated when the 
employee unassigned is the case manager. 

Injected Case Manager Only Displays First Name 

Task # 25446 

What was the issue? When injecting a client’s case manager into a form, only the first name 
populates. 

The patch When a case manager is injected into a form, the system will pull the 
employee’s first name and last name. 

eMAR Record Not Retained when Med Order Discontinued 

Task # 25415 

What was the issue? Medication was added to a client’s record via the Physicians Orders 
screen, scheduled for administration, and administered. When the med 
was discontinued via the Physicians Orders screen, the administration 
record was removed from eMAR and the database. 

The patch When a med is added via the Client Medication screen and has an 
associated eMAR schedule, a Discontinue button will be available on the 
Client Medications screen instead of a Delete button. 

When a med is added via the Physicians Orders screen and has an 
associated eMAR schedule that has not yet been administered, the 
Discont button will be available on the Physicians Orders screen. 

When a med is added via the Physicians Orders screen and has an 
associated eMAR schedule that has been administered, the Discont will 
not be available on the Physicians Orders screen. 

Note that the patch does not affect prescriptions created via the 
Physicians Orders screen. 
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Last Dispensed Column Header Renamed 

Task # 24747 

What was the issue? The column heading Last Dispensed in the eMAR Schedule Administration 
screen was not appropriate since Dispensed is the term used when a 
pharmacy fills out a prescription. 

The patch The column heading has been changed to Last Administered. 

Client Program Assigned Notification Not Firing for Indirect Assignment 

Task # 24681 

What was the issue? The Client Program Assigned trigger was not firing when a client was 
assigned to a program indirectly through a team assignment. 

The patch The Client Program Assigned notification triggers for an indirect program 
assignment when the following conditions are met: 

1. Program specified in trigger is assigned to the selected team 

2. Client is not already assigned to the program 

3. Employee is assigned to the client 

Partner Config Time Zone Not Used when Creating Orders 

Task # 25643 

What was the issue? When an order was created, the system used Eastern Standard Time 
instead of the time zone specified in Partner Config. 

The patch The date/time an order is created reflects the time zone specified in 
Partner Config. 

Order Refill Does Not Pull Current Physician 

Task # 25559 

What was the issue? An order was refilled and the physician from the original order was not 
autopopulated in the new order. 

The patch When refilling an order, the Physician name is set to the original 
prescriber. 
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Tx Plus Section Not Printing Where Expected 

Task # 26218 

What was the issue? When printing visit details in HTML or PDF, the Tx Plus section is printing 
at the top instead of in the order it appears in the form. 

The patch The Tx Plus section prints in the same order it is presented in when filling 
out the form. 

Edit Function in Bed Board: Overlapping Intervals & Initial Type Not Retained 

Task # 22657 

What was the issue? During edit of existing Bed Board interval, system allowed change to In 
Date that resulted in overlapping intervals (client was already assigned to 
a bed). If Initial Type was selected after the bed was initially assigned, the 
system did not retain the selection. 

The patch Bed Board edit functionality updated so overlapping intervals are no 
longer possible and the Initial Type is retained. When attempting to edit 
or add an interval that precedes an existing one, the following message 
will now display: 

Interval cannot be created when it is less than existing intervals 

Error Screen when Client Team Assignments Exceed 100 

Task 26466 

What was the issue? Got “Subscript out of range: 101” error message when trying to view the 
teams assigned to two clients. Both clients were assigned to all teams in 
the system. 

The patch The system can now display up to 300 team assignments for a client. The 
number of program assignments that can display has also been increased 
to 300. 
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Employee 

Same Notification Fired Three Times 

Task 24999 

What was the issue? Notification fired three times for the same event. 

The patch When a Partner Config notification removal setting is enabled, all future 
notifications of the type being deleted will be removed from the 
Notifications table. Previously, only existing notifications on employees’ 
schedules were removed. 

Schedule 

Schedule Print Not an Option when Using Chrome 

Task # 25839 

What was the issue? Unable to print the schedule when using Chrome. 

The patch When using Chrome, a print icon is available in the schedule. 

Unable to Write “No Show” Progress Notes 

Task 23207 

What was the issue? Unable to write No Show progress notes for group visit – the whole group 
notes came up instead. 

The patch Group visits can now use the Cancellation/No-Show form. You can begin 
the Cancellation/No-Show form from the Employee or Client schedule. 
When you begin it from the Employee schedule, the system displays the 
form for the first client in the group. 

When you complete the Cancellation/No-Show form, the “no show” visit 
is added to the client’s record and a cancellation entry that points to the 
no show visit is added to the both the Employee and Client Schedule. The 
client is removed from the group visit. 
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View Client Page Tooltip Missing when Using Firefox 

Task # 24936 

What was the issue? When using Firefox, View Client Page tooltip does not display when 
hovering over client icon. 

The patch Tooltip now displays in non-IE browsers. 

Visit 

Bad Visit ID Link in To Do List Notification for Employee Form 

Task # 25484 

What was the issue? When a notification was added to a To Do List for visit completion and the 
visit used an employee form, clicking the visit ID displayed the Client Visit 
List instead of the employee’s visit list. 

The patch If the visit type is an employee visit, the system displays the employee’s 
visit list. 

PRINT CLIENT VISIT in PDF Action Not Logged 

Task # 26009 

What was the issue? When the system is set up to print client visit documentation in PDF, the 
PRINT CLIENT VISIT action was not logged. 

The patch PRINT CLIENT VISIT action is logged when printing in HTML and PDF. 

Begin Visit Button Only Enabled After Eligibility Hover Over 

Task # 24954 

What was the issue? In Scheduled Visit popup, Begin Visit button not enabled until after you 
hover over the “e” for eligibility. 

The patch Functionality for eligibility tooltip changed so hover over is not necessary 
for Begin Visit button to work. 
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Group Notes in Header Portion in PDF Truncated on Print View 

Task # 25558 

What was the issue? The note field in the PDF version of the print view only displays the first 
100 characters. 

The patch The system calculates the appropriate row height for the notes field in 
HTML and PDF. 

Section in Form Repeats Unexpectedly in Print View 

Task # 24781 

What was the issue? Section in form repeated multiple times in print view but not in Visit 
Details screen. 

The patch Client visit print view functionality updated so when a question has more 
than one answer and notes, notes only appear once for the question (vs 
being repeated for each answer given). 

Print View Error on Approved Tx Plus Visits 

Task 26163 

What was the issue? Error message “Conversion from type 'DBNull' to type 'String' is not valid.” 
displayed when printing a visit with Tx Plus data. 

The patch The system checks for null values and replaces them with spaces. 

Billing 

Incorrect CPT Code when TRANSFER INSURANCE Is Undone 

Task # 23189 

What was the issue? When service was transferred to another payer, CPT code and modifiers 
updated correctly. However, when TRANSFER INSURANCE action was 
undone, CPT and modifiers did not revert back to those associated with 
the original payer. 

The patch UNDO function on TRANSFER INSURANCE line will now reprocess the CPT 
code matching. 
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Allowed Payer Types Not Included Billing Matrix Copied Entry 

Task # 25495 

What was the issue? When you used the Copy New Entry function in the Billing Matrix, allowed 
payer types were not copied into the new entry. 

The patch Allowed Payer Types will now copy to the new Billing Matrix line when 
you use the Copy New Entry function. 

Incorrect Insurance Attached to Visits 

Task # 24600 

What was the issue? Updating a payment to have a new payer resulted in a mismatch between 
the payer of record for previously applied money and the payer of record 
for the payment itself. 

The patch The system does not allow changing a payment payer once the payment 
has been reconciled to visits. However, you can update the payer if you 
undo all the applied payments. Patch also changes how a payment update 
is recorded in the ledger. If you change the payer on a payment, there will 
be two ledger entries: a negative amount against the original payer and a 
positive amount against the new payer. 

Denials Received for Partial Payments from Primary Payers 

Task 24055 

What was the issue? When payer paid a partial amount AND did not include any adjudication 
information as to why only a partial was paid amount, claim was denied for the 
following reason: “The COB information does not balance at the service level.”  

The patch Note that the following patch is only applicable when a payer requires Non 
Covered Amount. New Payer Config setting to show the non-covered 
amount. When Send Non-Covered Amount is selected, the system will 
send the AMT*A8 amount when 1) no amount was paid by payer and 2) 
there are no CAS segments included in the 837. 
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Reports 

Monthly Visit Totals by Client Not Displaying All Applicable Clients 

Task 25844 

What was the issue? If a visit did not have a payer, it was not included in the Monthly Visit 
Totals by Client report.  

The patch The system will now include visits that are not associated with a payer in 
the report. 

eMAR Tables Not Accessible via Ad Hoc for Export 

Task 26327 

What was 
the issue? 

Unable to create ad hoc eMAR reports since eMAR tables are not “visible.” 

The patch The MedSchedule and MedScheduleData2 tables have been added to the list of 
tables available for ad hoc reporting. MedSchedule is the actual administration of 
the med and MedScheduleData2 is the eMAR schedule for a med. 

Export Dropping Fields & Will Not Save Them when Put Back In 

Task 26457 

What was the issue? Custom fields that had more than 50 characters did not store properly due 
to a 50-character limit in the ExportBuilderItem table. 

The patch You can now select custom fields that are up to 150 characters long. 

Credible BI User Not Removed when Credible User Login Deleted 

Task 23724 

What was the issue? Employee had Credible BI access. When employee’s user login was 
deleted, his/her name still showed up in Credible BI. 

The patch User login delete functionality updated so when you delete an employee’s 
user login, his/her access to Credible BI is also removed. 
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Cross-Browser Compatibility 

Error when Clicking Attachment in Chrome 

Task # 24679 

What was the issue? On intermittent basis, error message displayed when clicking a client 
attachment: “Duplicate headers received from server The response from 
the server contained duplicate headers. This problem is generally the 
result of a misconfigured website or proxy…” 

The patch File names are now “wrapped” in quotes to prevent error. 

No Blue Multi Stage Approval Outline in Client Visit List in Non-Browsers 

Task # 25333 

What was the issue? When a visit is at the stage of employee’s approval role, he/she did not 
see the blue outline around Approval checkbox when using a non-IE 
browser. 

The patch Styling functionality updated for non-IE browsers so blue border will 
display. 

Injected Fields Not Working when Using Firefox 

Task # 25267 

What was the issue? When using Firefox, injected fields are not displaying correctly in form 
when documenting a visit. 

The patch When Firefox is the browser, the system will make the fields for injected 
data larger so they can hold and display the data. 

No Right-Click Print Option in Firefox & No Sig Box or Active X Support in Chrome 

Task # 25826 

What was the issue? Right-click print option for printing receipts or reminders not allowed in 
Firefox. When using a signature pad, Chrome does not show signature 
boxes and does not support Active X. 

The patch Software updated to fix printing issue. Other issues will be resolved once 
Topaz applet for cross-browser signature pad is in use. 



 

 

Patch List 43 Release 7.1 Configuration (v 1.2) 

Forms 

Odd Characters Are Displaying in the Form 

Task # 23784 

What was the issue? Odd characters are showing in the form. 

The patch The system removes all non-printable characters before saving form data 
to the database (only characters between ASCII 32 and 126 are allowed). 
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